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Introduction

NorriSize™, the Norriseal Valve Sizing Program, enables one to calculate the required C,, Flow
Velocity, Mach Number and Flow Noise based on a given set of parameters, and aids the user in
determining the appropriate valve selection for a fluid service application. The program can
automatically provide values for many common fluids; however, the user’s knowledge of the
environment is essential for proper valve selection for any service application. It is ultimately the user’s
responsibility to assure the data used for calculations is correct.

Version 3.0 of the program has been written from the ground up, and represents an
overwhelming improvement over version 2.x in terms of program interaction and interface design.
Efforts have been focused on providing a flexible, project based environment and modularizing the
interface to cleanly separate project management tasks from valve sizing. New features include the
display of C, curves, expanded printing options, a simple address book and persistent user preferences
which make the program a more effortless tool for sizing valves.

Flow coefficients are calculated using the latest ISA standard S75.01.01-2002 Flow Equations
for Sizing Control Valves. Unfortunately, there has been no progress in the draft standard dS75.07.01,
so noise prediction is still calculated using ISA standard S75.17-1989 Control Valve Aerodynamic
Noise Prediction. Calculation accuracy has been improved over the previous version by implementing a
more robust specific gravity calculator and expanding fluid property temperature ranges. Calculation
messages have been improved to provide the user with information to correct the problem which causes
the message to appear.

Installation

Installation of the Norriseal VValve Sizing Program requires that you have an installed Java
Runtime Environment (JRE) version 1.4.x or 1.5.x. Issues have bee identified in version 1.6.x which
have not been fully investigated. Regardless of whether you have received your copy of the program on
CD or downloaded from our website, you can always get the appropriate version of the JRE from Sun
Microsystem’s website: http://java.sun.com.

System Requirements
e Microsoft Windows 2000/XP (compatibility w/ Vista is expected)
Pentium 11-233 or higher
256MB Memory
50MB Free Hard Disk Space
CD-ROM (for CD installation)
Installed Printer (for reports)
Mouse or other pointing device

To install the NorriSize™, Norriseal Valve Sizing Program, simply double-click on the self-
extracting executable and select a directory into which the files are to be extracted. To run the program,
double-click on the NorriSize shortcut found in the directory where the files were extracted. The first
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time the program is executed, Agent and Company dialogs are displayed for entering user-specific
information. See Simple Address Book for creating and maintaining Agent and Company information.

Project Manager Module

The Project Manager provides the main interface to create and maintain projects. The module
consists of the Project Tree on the left and the Project Information panel on the right. The Project Tree
displays open projects and allows the user to navigate through all the items contained within these
projects. The Project Information panel displays project and project item information.

__ 1 Projects Project- Complejo Santa Rosa
= | Cormplejo Santa Rosa
® PCV_13011T Matne Complejo Santa Rosa
® PCY_130118 Customer POM &,
#® PRY-130120/30121 Contact
® PCY-130110 Aoent Eill Lutz
& PCY-130111 Carmpary Marrizesal
® PCY-130112 Coded By WisL
® PCY-130113 Date 2005-07-158
® PCY-130114 Motes
® PCY-130115 PID Hurmber
® PCYV_130116 Guote Fef [ N e I
% ) Atwater Valley Gas Huk Platform ||| Project lterm - PCAV-130117
___| Daily Sizing
* PV-s021 Tag Nlert:uer Py -130117F
® PyV-a031 Cuantity 1
# PYv-8041 otes
Service Data for PCY-130117
=ervice Type zas
Fluicd Matural Gas
Pipeline Data for PCY-130117
Ip=trearn Pipe G.0in, Sch STD
Dovwenzstream Pipe G.0in, Sch STD
Walve Data far PCY-130117
Style Control %alve
hocdel 27004 2700E Control Walve
Sizelllass 4 Oin AME50
Trirn Style Equal Percentage (BCC)
Tritn SizefCw 4 0in-195.0

Project Tree

Projects that you create are displayed in the Projects folder of the project tree. A second project
folder named Daily Sizing is a permanent project that appears below the Projects folder, and can be used
for quick sizing of general inquiries where creating and maintaining a project is not desirable. Project
items are displayed under its parent project using the tag number given when the item was created.
Selecting a project or project item in the Project Tree will display its information in the Project
Information panel. Double-clicking a project item will take you into the Sizing Module for that item.
©2007 Norriseal 4
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Project Information Panel

The Project Information panel displays project, item and specification information for the
currently selected project. Only the current project item and its parent project can be edited from the
Project Information panel; specification information (if available) is read-only and is intended only to
aid the user to more easily identify where and how the item is used. Each display list can be minimized
using the Details<< button, which is beneficial for low resolution screens when all the information
panels cannot be seen at one time. By minimizing an information panel, it is not required to utilize the
scroll bar to view information that cannot be displayed due to low resolution screens. An option to
permanently hide one or all of the specification information panels is also available to customize project
information display to suit the user’s preference.

Creating Projects

New projects are created via the Project Wizard. To create a new project, select the File=>New
Project... menu item, or the first icon () on the project toolbar. See New Project... in the File Menu
section for details on creating new projects.

Creating Project Items

New project items are created via the Project Item Wizard. With a project active (i.e. displayed
in the Project Information panel), select the File>New Project Item... menu item, or the second icon
(EIJ) on the project toolbar. New items can also be created while in the Sizing Module. See New Project
Item... in the File Menu section for details on creating new project items.

Editing Projects and Project Items

Projects and project items can be edited within the Project Information panel. There are two
types of editors within the information panels: an inline text editor for character fields such as the
project name or tag number, and an external editor for multiline fields such as an address book object or
notes. External editors are shown as an ellipsis button to the right of the selected cell. When pressed,
the external editor is displayed to allow changes to be made to the underlying data.

Figure 1: Inline text editor Figure 2: External object editor
Project- Complejo Santa Rosa Project- Complejo Santa Rosa
Matne |C|:umplej-:| Santa Roza | [atme Complejo Santa Rosa
Customer POAwSA Custamer PO SA
Cortact Cantact
Agert Eill Lutz Agent Eill Lutz
Campaty Marrizeal COmpEny Moarrizeal
Coded By WL Coded By WL
Crate 2005-07-15 Crate 2005-07-15
Motes Motes | ]
PIC Murmber PIC Murnker
Guote Ref Q071 EvL 00 Gote Ref 5071801 00
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Daily Sizing
The Daily Sizing project is automatically updated with the current date and a generic quote

reference every time the program is loaded. An option to automatically remove all items of the Daily
Sizing folder when the program is closed is available to simplify management of the Daily Sizing folder.

Address Book

The Valve Sizing Program incorporates a simple address book as a convenient method for
storing company and agent information. The address book is not directly accessible via any module, but
is utilized internally by the program for maintaining contact information in a project. The Customer,
Contact, Agent and Company fields are address book data objects which can be edited through the
external object editors.

| AGENT INFORMATION EJ| | Cospany INFORMATION
_ Agent Information Campany Infarmation
ew Entry Iame e Entry ame
E-mail Sireet
R Erit i
emove ety | [Phone Remave Ertry City -
Ext. StateProvince
Faux ZIPiPostal Code
Initial= Search.. Country
Logo

e New Entry — Creates a new agent or company address book entry. Multiple entries can be
created during the dialog session.

e Remove Entry — Permanently removes the current address book entry from the database.

e Search — Opens the Search Address Book dialog. The list displayed depends on the role of the
object being edited (i.e. Customer vs Company). For example, the Customer search dialog will
display customers only, whereas the Company dialog will typically only display the user’s
company. The latter case is illustrated below. Search dialogs cannot edit data.

| SEarcH Apbeess Book =]
Morrisesl Marne Morrisesl
=treet 11122 West Little vork
City Housztan
StateProvince T
ZIPPoztal Code TI0H
Courtry =n
Logo
[ Ok l [ Cancel ]
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NorriSize™

Changes made to the currently selected address book entry are dynamically updated when the
editor is closed using the OK button or New Entry/Search is selected. Changes made to the currently
selected item will be discarded when the editor is closed using the Cancel or Close Window buttons.

Valve Sizing Module

The Valve Sizing module provides the main interface to enter service application parameters and
perform sizing calculations. The module consists of the Service Selection panel at the top, the Service
Data panel in the center, and the Sizing Results panel at the bottom.

Zervice (Gas w | Fluid Matural Gas b Override
Pipe Selection Valve Selection
Upstream (3.0 | W Yalve Model |[2700A52700E Contral Valve W
Schedule (S0 » Walve Size 3.0 W Prez=sure Class |[&ARNS] 900 W
Dowenztream (3.0 | W Trirn Style  |Linear (BCC) | TrimSize 15 b4
Scheduls (30 w
Service Data far PV-8031 [w]cv [ Flow
Pararnster it Fate Mirrirriar Morenal Mazirmuem
Flowy Rate Pt =ted 5 cday 5.25 25 7a
Inlet Pressure (P1) pEi_g 1,250 1,850 1,850
Outlet Pressure (P2 pEi_g 1,100 1,500 1,500
Pressure Drop (AP i a0 350 250
Tetmperature (T F 120 120 120
Cotnpressibilty (2 nr2 0.r2 072
Molecular Mass (M) 2202 2202 2202
Specific Gravity (G 0.7e 0.7e 076
Specific Heats Ratio (k) 1.03 1.03 1.93
Critical Pressure (P2 pEi_g EST .41 BST .41 57 .41
Critical Termperature (T F -04 A7 -Q4 27 -84 27
Sizing Results for PA-8031

Sizing Results LIkt Mitirriee Marinal hazirauen
Calculsted Coefficient Cy 28134 180578 S5.3485
Floeay Moize SPL dE A 814632 529145 855670
Critical Prezzure Drop (AP Chaked) pi 1,799.4315 1,799.4315 1,799.4315
Actual Prezzsure Drop (AP pi 7a0 380 350
Fequired FL 1] ] 1]
Fated FL 055 n.es 055
Walve Outlet Welocity ftiz 131053 450259 14328588
Pipe Outlet “elocity ftiz 14.0247 491475 1533411
Percentage Lift 158.7039 47 338 85 BE04
Percerntage Cw 4 4657 28 BB 89442
Walve Mach Murmber 0.00s2 0.0239 0.0902
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Service Selection

The Service Selection panel is used to describe the service environment, and contains the

following components:

Service — A drop-down list for the type of fluid service: Liquid, Gas, Steam or Two-Phase.
Fluid — A drop-down list for selecting the fluid. The fluid list is automatically updated for the
service type selected. Selecting a different fluid when the Fluid Override is checked will disable
the override for the new fluid in order to calculate its properties.

Fluid Override — A check box to override the default fluid properties calculated by the program.
Checking this component allows the user to enter custom fluid data which more accurately
reflects the service environment, such as specific gravity or vapor pressure. Unchecking the
component reverts fluid properties to their predefined values based on the current temperature
and pressure of the service data. When the Fluid Override is unchecked, the fluid is considered
dynamic because changes in service conditions recalculate the fluid’s properties. When checked,
the fluid is considered szatic because changes in service conditions will not affect fluid property
values.

Calculate button — Calculates the flow coefficient and noise prediction. The program does not
perform calculations automatically. NOTE: Any change made to the data of the sizing module
requires the user to recalculate the results. The percentage of rated C, is updated, for the
benefit of comparison, in the sizing results panel when a change to the trim is made.

Pipe Selection — Provides pipe sizes and schedules to select for the service. NOTE: The pipe
selection panel is not enabled until a preliminary C, has been calculated.

Valve Selection — Provides valve and trim options to select for the service. NOTE: The valve
selection panel is not enabled until a preliminary C, has been calculated.

Service Data Panel

The Service Data panel is used to describe the variable properties of the service environment,

and contains the following components:

C, check box — Selected by default, calculations are solving for C,

Flow check box — When selected, calculations are estimating flow. NOTE: Flow calculations
are only an estimate, and may not accurately reflect the maximum flow due to the iterations
required to solve for C,. It is the user’s responsibility to recalculate solving for C, to determine
if the estimated flow meets the actual C, rating of the associated trim.

Service Parameters table — Used for entering service data, the table lists the required parameters
for the currently selected service type and provides up to three case scenarios for calculating a
flow coefficient. The case scenarios have the default names of Minimum, Normal and
Maximum, but may be changed on a per-item or global basis to suit the user’s preference.

The Service Parameters table contains both system and fluid service conditions. The values

required for entry depend on the type of service a valve is being sized for.

Steam Service

Flow Rate — The rate of flow of the fluid through the valve
Inlet Pressure (P1) — The line pressure at the valve inlet
Outlet Pressure (P2) — The line pressure at the valve outlet
Pressure Drop (AP) — The pressure drop across the valve

©2007 Norriseal 8
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o Temperature (T) — The temperature of the fluid flowing through the valve

Liquid Service

In addition to the required values of Steam Service, Liquid Service requires the following values:
Vapor Pressure (Pv) — The vapor pressure of the fluid at the specified temperature for the case
Critical Pressure (Pc) — The critical pressure of the fluid

Viscosity (V) — The viscosity of the fluid at the specified temperature for the case

Specific Gravity (Gf) — The specific gravity of the fluid at the specified temperature for the case

Gas Service

In addition to the required values of Steam Service, Gas Service requires the following values:
Compressibility (Z) — The compressibility of the fluid at the specified inlet pressure for the case
Molecular Mass (M) — The molecular mass of the fluid

Specific Gravity (Gf) — The specific gravity of the fluid at the specified temperature for the case
Specific Heats Ratio (k) — The specific heats ratio of the fluid

Critical Pressure (Pc) — The critical pressure of the fluid

Critical Temperature (Pc) — The critical temperature of the fluid

Two-Phase Service

In addition to the required values of Liquid Service, Two-Phase Service requires the following
values:
o Specific Gravity Gas (Gf) — The specific gravity of the gas at the specified temperature for the
case
e Specific Heats Ratio (k) — The specific heats ratio of the gas
Note: Two-phase sizing does not provide flow velocities or noise prediction calculations.

Case Data Entry

Case data entry is a simple process of entering the required parameter values for the specified
service type. Entry can begin in any of the min/norm/max scenario columns. The rows have been
organized so that all non-fluid related service conditions are at the top, which allows the program to
calculate standard fluid properties once all service condition values have been entered. Once a value has
been entered, pressing the <Enter> key will focus entry to the next cell in the current column unless the
active cell is the last row, in which case focus will jump to the beginning of the next column. Cell
navigation can also be performed by pressing any of the arrow keys.

If the fluid properties need to be overridden, it is recommended that all case scenarios’ service
conditions be entered prior to selecting the Fluid Override checkbox. This allows the Service Data
Panel to dynamically calculate the standard fluid properties based on the service conditions entered for
the current scenario. Otherwise, by selecting the Fluid Override before all scenarios have been entered,
the fluid properties become static and will be copied to the next case without taking into account
changes in pressure or temperature. See Fluid Override in Service Selection for more information.

Units Selection

Unit selection is straightforward through the use of drop-down lists next to the parameters that
are not dimensionless. When selecting a unit for Inlet or Outlet pressure, the corresponding parameter is
changed automatically to the selected unit. The Inlet and Outlet pressure units will always use the same

9 ©2007 Norriseal
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unit of measure, including the Pressure Drop. Fluid parameters, such as Vapor Pressure and Critical
Pressure, may utilize different units of measure. Flow Rates have the time unit independent of the
quantity unit as a matter of convenience and to minimize the chance of error in performing manual rate
conversions. To change the unit of measure for a parameter, right-click in the far right (east) area of the
cell to display the drop-down list of available units.

Service Data for lterm 1 [« Cv [ Flow

Parareter IImik Rake Pinirnur Mormal PMazxirnuri
Flows F.ake qal :E mnin
Inlet Pressure (P12 bbl
Cuklet Pressure (P2 ft®
Pressure Drop (AP in®
Temperature (T) e
Yapor Pressure (Py) gal
Critical Pressure (Pr) I
Viscosiky [}
apecific Gravity (GF) kq

Pipe Selection

Specifying upstream/downstream pipe size and schedule in the Pipe Selection panel can be as
quick as two selections. When making selections for upstream pipe, the downstream pipe is
automatically set to the same size/schedule. However, if downstream pipe is different than the upstream
pipe, changes to the downstream size/schedule can be made without affecting the upstream
size/schedule. Pipe selections are available in inches and schedules defined in ANSI B36.10M-2000.

Valve Selection

The Valve Selection panel provides drop-down lists for specifying the valve to be sized. Each
list box is dynamically updated to reflect a change in the valve/trim selection. Pressure classes for
Norriseal valves range from ANSI 150 to ANSI 2500, depending on the valve model. The Valve Size
and Trim Size list boxes display rated C, values when the mouse is hovered over the list (illustrated
below), allowing the user to select the appropriate valve/trim size based on the preliminary coefficient.
Rated C, for valves is based on the largest Quick Opening trim size available for each valve size. All
valve and trim selections are in inches.

Acronyms in parentheses of the Trim Style list box denote the following:
e UPC - Unbalanced Plug Control trim
e BPC - Balanced Plug Control trim
e BCC - Balanced Cage Control trim

Valve Selection

Walve Model |2200/2220 Conkrol Yalve W

Walve Size (2.0 |w Pressure Class |[AMNSI 150 W

Trimn Style |20 .riing (LIPC) w| Trimsize (0.5 |+
2.0
Cv=15.4
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Calculating Valve Coefficient

For new project items, flow coefficient calculation is a two-step process: calculating a
preliminary coefficient and calculating a final coefficient. Pressing the Calculate Button (3) will
perform calculations for all case scenarios in the Service Data Panel.

Preliminary Coefficient

In order to make valve selection more efficient, a preliminary calculation based on generic flow
equations is performed prior to making pipe and valve selections. With a preliminary flow coefficient,
the user can more easily determine the valve type, size and trim, doing away with the need for trial and
error methodologies. After performing the preliminary calculation, the Valve and Pipe Selection panels
become accessible, allowing the user to complete the specification for final flow coefficient and noise
prediction calculations.

Final Coefficient

The final coefficient calculation is a combination of flow, flow velocity and noise prediction
calculations, and can be determined after the valve and pipe selections have been made. When a final
calculation is performed, any messages generated from the calculations are displayed in a dialog and are
ordered by case scenario. If C, data is available for the selected trim, a chart which plots the final C,
along the trim’s C, curve can also be displayed.

Sizing Results Panel

Preliminary and final C, calculation results are displayed beneath the Service Data panel in the
Sizing Results panel. The results displayed in the Sizing Results Panel vary depending upon the type of
service selected:
e Calculated Coefficient — The flow coefficient calculated, either preliminary or final
e Flow Noise SPL — The predicted noise generation
e Critical Pressure Drop — The pressure drop limit whereupon choked flow occurs
e Actual Pressure Drop — The actual pressure drop across the valve
Required FL — The required liquid pressure recovery factor for the valve at the specified service
conditions (liquid only)
Rated FL — The rated liquid pressure recovery factor for the selected valve model
Valve Outlet Velocity — The flow velocity at the valve outlet
Pipe Outlet Velocity — The flow velocity at the pipe outlet
Percentage Lift or Degrees Open — For plug style trim valves, the percentage of plug travel
required to achieve the specified flow rate. For rotary style valves, the amount of rotation of the
disc/ball to achieve the specified flow rate.
e Percentage C, — The ratio of the calculated coefficient to the rated coefficient of the valve/trim
selection
e Valve Mach Number — The ratio of the flow velocity in relation to the speed of sound in the fluid
media (gas/vapor only)

11 ©2007 Norriseal
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File Menu

New Project... (22)

Displays the New Project Wizard and creates a new valve sizing project in the main Projects
folder. New projects can be created while in either the Project Manager or the Sizing Module.

e Project — The name of the project to create. This is the name that appears in the project tree
panel. This is a required field.

e Customer — The customer for which the project is prepared and will appear in the heading of the
printed report. This is a required field.

e Agent — The name of the company’s agent assigned to the project. This field is automatically
filled with the current user’s information. It can be changed if, for instance, someone other than
the current user is the main Agent assigned to the project.

e Quote Reference — The quote number/reference assigned to this project. This is a required
field.

e Entered By — The initials of the user performing the valve sizing, if different than the Agent.

| ProJeeT Wizamn &

Project
Cuskorner E]
Agent  Eric Langford E]

Cuote Ref,

Entered By Cate | Aug 11, 20048

[ Ok, ] [ Cancel ]

New Project Item... (&)

Displays the Project Item Wizard and creates a new project item in the currently selected project.
A project must be selected for this action item to be enabled. New project items can be created while in
either the Project Manager or the Sizing Module.

e Tag No. — The tag number of the valve (if required) or name of the project item if no tag number
is used. This is the name that appears in the project tree panel. If this field is left blank, the
default tag name “Item x” is used, where x is the current item count.

e Quantity — The quantity of valves required for this item.

e Valve — The type of valve to be sized. This allows the Sizing Module to more accurately
calculate a preliminary C,.

e Copy From — Select the project item to use for creating a new project item with identical data

©2007 Norriseal 12
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| PeosecT ITeM Wizamn =]

Tag ko, Cwantity | 1

Yalve |Contral Valve v

Copy From |=sMone= ™

[ I, l [ Cancel ]

Open Project... (&)

Displays the Open Project dialog for selecting one or more projects to add to the Project Tree
panel. To select multiple projects, hold down the <Control> key and right-click on each of the desired
projects to open.

Open ProsecT
Demo Project2 Froject- Flow Equation Examples
Flow Equation Examples Matne Floww Equation Exarmp... A
Atweater Valley Gas Hub PlatforCustomer
harcao Polo Cartact
Mizcelaneous Agent Eric Langford
Complejo Sarta Rosa COMpEty Mo el
Coded By eel
Diate: 2004 -06-01
<] 3 Jnotes 5
[ Ok l [ Cancel ]

Close Project (%)

Removes the currently selected project from the Project Tree panel. The user will be prompted
to save any changes made to the project prior to being closed.

Save Project (&)

Saves any changes to the currently selected project and/or project item. The user will be notified
that any changes made to the specification of a project item will generate a recalculation prior to being
saved.

Export...

Displays the Export Wizard to export projects and/or project items to an external data file.
Projects are saved in an XML format which can be imported back into the program. The Export Wizard
consists of the following components:

e Directory Path text field — determines the directory location files are exported to
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e File Chooser button (...) — displays a File Chooser dialog for selecting the directory path
e Projects/Items button — switches from project selection to item selection, and vice-versa
o Select All checkbox — selects all items in the display list
e Project list (Item selection only) — project drop-down list for item selection
o List Selection panel — lists projects/items to select from and displays related information. To
select multiple projects/items, hold down the <Control> key and right-click on each of the desired list
items.
Exrorr Wizam | | | ExrorT Wizaen &
Gizc E] Gohisc E]
@) Projects (Oittems [ Select &0 () Projects (3) tems  |Flow Equation Examples w | [ select &1
Detno Project2 FProject Example 1 Froject ltem
Flow Equation Examples Mtz Flovwy Equation Exarrp... | » Example 2 Tan Murnber Exatriple 1
Atwater Walley Gas Hub Platfor Customer 1Z4, Flowy Equations [ Exammple 3 Cgantity 1
Marco Polo Contact Motes
Mizcellaneous Agent
Draily Sizing Conpary
Complejo Santa Rosa Coded By el
Crate 2004-06-01
£ ¥ ctes hd
Export Item

Displays a File Save dialog to export the currently selected project item to an external data file.
Exporting from this menu item differs in that the variables from flow calculations are included, and is
intended for technical support purposes only. NOTE: Files created may not be capable of being
imported back into the program.

Print...

Displays the Print Wizard for printing sizing reports of project items from the projects listed in
the Project Tree panel to the current default Windows printer. The Print Wizard layout is similar to the
Export Wizard, and consists of the following components:

e Print to file checkbox — when selected, writes sizing reports to a PDF file

e Directory Path text field — determines the directory location files are exported to
e File Chooser button (...) — displays a File Chooser dialog for selecting the directory path
e Project list — project drop-down list for item selection
e Select All checkbox — selects all items in the display list
e List Selection panel — lists items to select from and displays related information. To select
multiple items, hold down the <Control> key and right-click on each of the desired items to print.
Print to File

The Print Wizard provides the user with the ability to save reports to a file by selecting the Print
to file checkbox. When selected, the file location can be chosen by either typing the directory path in
the text field or via a directory selection dialog by pressing the ellipsis to the right of the text field. It is
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highly recommended to use the selection dialog to ensure a valid directory path is chosen. Each project
item selected will have its sizing report saved to a PDF file using the tag number as the filename.

PrinT

[ Prirt ta file

Ph-8021/8051 | Project Iterm
P-8031 \Tag Murnber Pr-B021/8051
P-5041 Gantity 1

;Nntes

[ I l [ Cancel ]

Print Project
Prints all items of the currently selected project to the current default Windows printer.

Print Item (=#)
Prints the currently selected project item to the current default Windows printer.

Exit
Closes the Valve Sizing Program. The user will be prompted to save any changes made to the
project prior to program shutdown.

Edit Menu

Options

Displays the Options dialog for customizing various aspects of the Valve Sizing Program and
consists of three tabs:

e General Preferences — customizes the project and sizing modules

e Default Units — customizes the units used for new project items

e User Info — customizes the Agent and Company information for the current user

General Preferences

Project Module
e Recent Projects — sets the number of projects to load upon program startup
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o Tree Panel Width — sets the width of the Project Tree panel in pixels (NOTE: manually
resizing the tree panel using the divider will not change this value)

e Remove Daily Items — determines whether the program deletes all items in the Daily
Sizing project upon program exit

o Service Data View — sets the visibility of the Service Data information panel

e Pipeline Data View — sets the visibility of the Pipeline Data information panel

e Valve Data View — sets the visibility of the Valve Data information panel

Sizing Module

Case Name 1 — sets the name of the first case scenario for new project items
Case Name 2 — sets the name of the second case scenario for new project items
Case Name 3 — sets the name of the third case scenario for new project items

Decimal Precision — sets the number of decimal places to display in the Service Data and
Sizing Results panels

s Y
QrTIONS
izeneral Preferences | Default Units | User Infortmation
Project Module Sizing Module
Fecent Project Court 2 Casze Marme 1 it
Tree Pane Width 220 Caze Mame 2 Marmal
Remaove Daily tems ] Caze Mame 3 haitriLm
Service Data Wiewy Decimal Prec. 4
Pineline Data Wiew
valve Data Wiew
[ ik l [ Cancel ]

Default Units

As of the release of v3.0, all service and fluid units of measure can be customized for new
project items with the exception of viscosity, which will be added in a later release. The default pressure
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unit applies to both inlet and outlet pressures, as well as pressure drop (which cannot be changed). For
two-phase service, the Liquid Flow Period is used as the default time period.

QPTIONS '

Genetal Preferences | Default Units | User Informstion

Service Unit Defaults

Liguid Flowe Rate - .

Ligguic Flosee Period |\ min "

Gas Flow Rate =td = w

Gaz Flow Period  |hr hd
Pressure Unit pEi_g e
Temperature Lnit F hd
Fluid Unit Detaults
Critical Prezsure Unit psi_a W
Critical Termperature Unit  |F b
Yapor Pressure Uit psi_a W
[ o] l [ Cancel ]

User Information

In the event that a user’s contact or company information changes, updates to the address book
can be made through the User Information tab. User information can be modified by one of two ways:
editing the existing entry or creating/selecting a new entry. In order for any address book entry to be
saved to the user’s profile as the default Agent/Company, it must be created or selected via the User
Information tab and pressing the OK button of the Options dialog.

Editing an Existing Entry

When editing an existing Agent or Company address book entry, the changes made will
be reflected in all existing projects referencing the entry. This method is useful for updating
phone number or e-mail address changes.

Creating or Selecting a New Entry

In some instances, such as having secondary contact information or company address, it
is beneficial to create a new address book entry. After creating or selecting a new entry, it will
be used as the default Agent/Company for new projects; existing projects will retain the original
Agent/Company entry.
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Agent Infarmation
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Remowve Entry Phiore 713-466-3552
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Company Infarmation
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Search... Country =
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[ o] l [ Cancel ]
Clear Case

Displays a sub-menu of the case scenarios from which to choose. Selecting a case scenario from
the sub-menu will remove all service data and sizing results for that case.

Clear Service Data

Removes all service data and sizing results for each case scenario, effectively reverting to a new
item state. Valve and pipeline selections are not affected.

Case Names

Allows modifying case scenario names from the default profile names found in the General
Preferences tab of the Options menu item. Alternate case names are specific to the project item for
which they were modified.

Calc Prelim C, ()

As a matter of convenience, a preliminary C, using the standard generic flow equations can be
calculated at any time.
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Create New Fluid (1)

Displays the Create New Fluid wizard to create a custom fluid that is not available in the
standard fluids included with the program. Custom fluids are restricted to a single state, e.g. property
values are static and should reflect a fluid’s state at the given temperature and pressure. After a custom
fluid is created, it is set as the selected fluid for the current project item. The custom fluid only needs to
be created for the initial case scenario. When added to the Sizing Module, it is set as a permanently
overridden fluid which allows fluid property modifications to the other case scenarios. Custom fluids in
the Fluid list are denoted with an asterisk (*) in front of the fluid name.

Creating a Custom Liquid

Creating a custom liquid is a straight forward process - all fluid property values are required.

e Name — Enter the name of the fluid; do not enter an asterisk before the name, this is done
automatically by the program

e State — switches between liquid and gas custom fluids

o Temperature and Pressure — select the appropriate unit of measure and enter the values at the
valve inlet. NOTE: Temperature and Pressure inputs are not required, but are included to
provide a complete view of the fluid state while creating the fluid.

e Critical Pressure — select the appropriate unit of measure and enter the critical pressure of the
fluid

e Molecular Mass — the molecular mass of the fluid

e Specific Gravity — the specific gravity of the fluid at the given temperature

e Vapor Pressure — select the appropriate unit of measure and enter the vapor pressure of the fluid
at the given temperature

e Viscosity — the dynamic viscosity of the fluid at the given temperature. NOTE: As of initial
release, only centipoise is supported for viscosity.

Ceeate New Frun
Fluid Properies
Property LInit “alue
Marme =Mewy Fluid=
State Licquict
Temperature F
Pressure pEi_a

Critical Pressure pE_a
holecular Mazs

Specific Gravity
“apar Pressure psi_a
Wiscosity P

[ 1K l [ Cancel ]

19 ©2007 Norriseal



VaLVE SIZING PROCRAM NorriSize™

VERSION 3.0

Creating a Custom Gas

Creating a custom gas is a little more complex than its liquid counterpart. In addition to the

property values for liquid (except vapor pressure), gases include the following required properties:

Critical Temperature — the critical temperature of the fluid

Specific Heats Ratio — the ratio of specific heats of the fluid. NOTE: This is typically a difficult
value to obtain, therefore a value of 1.4 (SHR of oxygen) can be used when the fluid SHR is
unknown. However, care must be taken to use a valid SHR because it is an integral part of
the flow equations; e.g. if the actual SHR of the fluid is lower than that of oxygen, the valve
may be undersized.

Compressibility — the compressibility of the fluid at the given pressure. NOTE: A value of 1.0
can be used when the fluid compressibility is unknown. However, care must be taken to
obtain a valid compressibility factor when a valve is operating at high pressures; e.qg. if the
actual compressibility is lower than 1.0, the valve may be oversized.

Additional notes regarding fluid properties for gases:

Viscosity — viscosity for gases can be difficult to obtain, therefore a value of .02cP can be used
when the fluid viscosity is unknown. Gas viscosities are typically very low and have minimal
impact on the flow coefficient, so correctly sizing a valve when the viscosity is unknown can be
accomplished with high confidence.

Molecular Mass Vvs. Specific Gravity — specific gravity of gases can be assumed to be a direct
relationship to the molecular mass of oxygen. Therefore, if one of these values is unknown, it
can be determined from the following equation:

M+ M, = Gs

where
Ms = molecular mass of custom fluid
M, = molecular mass of oxygen (32.0)
Gt = specific gravity of custom fluid

Ceeate New Foun
Fluid Properies
Property LInit “alue
Marme =Mewy Fluid=
State Gas
Temperature F
Pressure pEi_a

Critical Preszure pEi_a
Critical Temperature |F

Mulegglar Mas.s
Specific Grawvity
Specific Heats Ratio
Yizcosity cP
Campressibility

[ I l [ Cancel ]
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Copying From an Existing Fluid
Often times there are fluids which have similar properties. In such cases, select the Copy ...
button to display the Select Fluid dialog which has the following components:

e Custom Fluids — checkbox to display only custom fluids that have been created for other project
items. The list displays a custom fluid for each case scenario, which typically have different
pressure/temperature ranges and the related fluid property values at those ranges.

e All Fluids — displays all fluids in the list panel

e Liquid — displays only the predefined liquids in the list panel

e Gas — displays only the predefined gases in the list panel

NOTE: As of the initial release, the predefined fluids only provide constant fluid property
values (Critical Pressure, Molecular Mass, etc.).

SeLeeT FLun =]

Custom Fluids &) AllFluids () Liquid () Gas

Yy

Condensate FIMarne *Condensake sl
*Condensate State Liquid
:EE:SZ:EZE: Terperature Unik F
P Ternperakure 107.0
P Pressure Linik psi_a
Harosens Pressure 2.0
*Produced Well Fluids Molecular Mass 1333
_NCrikical Pressure Lnik psi_a
*Produced Well Fluids ¥~ ritiral Preczive ErScH| ¥

[ ] 4 ] [ Cancel ]

Delete Project
Permanently deletes a project from the database and removes it from the project tree panel.

Delete Project Item
Permanently deletes a project item from the database and removes it from the project tree panel.

View Menu

Specification Views

Displays a sub-menu of the specification views from which to choose. Menu items which are
checked are displayed in the project information panel. Deselecting an item will hide the associated
information panel, and vice-versa. The Specification Views menu is linked to the General Preferences
tab in the Options menu, therefore changes made are persistent and saved to the user’s profile.

Project Items

As a matter of convenience, a sub-menu listing project items in the current project is displayed,
allowing the user to switch to a different item while in another module.

21 ©2007 Norriseal



VaLVE SIZING PROCRAM NorriSize™

VERSION 3.0

Cv Curve ()
Displays the C, Curve associated with the selected valve trim, and plots the points of intersection
of the calculated C, for each case scenario.

Calculation Messages (%)
Displays the messages generated from coefficient and noise prediction calculations.
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Appendix A: Walkthrough

Example 1

This example uses the Daily Sizing project (and assuming no items exist) to size a basic water

application using the predefined fluid properties and does not utilize a tag number or quantity.

Fluid: Water

Flow Rate: 15,000 barrels/day
Inlet Pressure: 15 psig

Outlet Pressure: 10 psig
Temperature: 120 F

Upstream Pipe: 8in Sch 40
DownStream Pipe:  8in Sch 40

Valve Style: Control Valve

1. Create a new project item

1.1. Press the Project Manager button to display the Project Module.
1.2. Select the Daily Sizing project in the Project Tree panel
1.3. Display the Project Item Wizard by selecting the File »New Project Item... menu item or
pressing the & button in the Project toolbar.
1.3.1. Since there is no tag number and the default valve style is for a Control Valve, press the
OK button.
1.3.2. The new project item is created using the default name /tem I and added to the Daily
Sizing project.
1.4. Double-click on the /tem I node in the project tree or press the Sizing Module button to begin
sizing the valve.
Service and fluid selection
2.1. The default service for a new item is Liquid and the default fluid is Water.
Service parameters data entry
3.1. Flow Rate
3.1.1. Select bbl in the Unit column
3.1.2. Select day in the Rate column
3.1.3. Enter /5000 in the Normal column
3.2. Inlet Pressure
3.2.1. Select psi_g in the Unit column
3.2.2. Enter 75 in the Normal column
3.3. Outlet Pressure
3.3.1. Enter /0 in the Normal column
3.4. Temperature
3.4.1. Select F in the Unit column
3.4.2. Enter 120 in the Normal column
Calculate a preliminary C,
4.1. Press the @ button to calculate
4.2. A preliminary C, of 194.627 is displayed in the Sizing Results panel
Pipe and valve selection
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5.1. Pipe Selection
5.1.1. Select 8.0 in the Upstream list box (the Downstream size is automatically selected)
5.1.2. Select 40 in the Schedule list box (the Downstream schedule is automatically selected)
5.2. Valve Selection
5.2.1. Select 27004/2700E Control Valve for the Valve Model
5.2.2. Select 8.0 in the Valve Size list box (NOTE: Hovering the mouse cursor over the list
selections will display the rated Cv of the valve)
5.2.3. Select ANSI 150 in the Pressure Class list box (NOTE: ANSI 150 is rated up to 285psi)
5.2.4. Select Equal Percentage (BCC) in the Trim Style list box
5.2.5. Select 6.0 in the Trim Size list box for a max Cv of 508 (NOTE: Hovering the mouse
cursor over the list selections will display the rated Cv of the trim)
6. Calculate a final C,

6.1. Press the @ button to calculate

6.2. The Sizing Messages dialog is displayed, stating there were no messages generated by the flow
and noise calculations. Press OK to close the window.

6.3. A final C, of 194.773 is displayed in the Sizing Results panel, which is 38% of the valve’s flow
capacity under normal conditions. The predicted noise generation is 56.4601dB, which is
acceptable.

7. Save the results

7.1. Press the B button to save the item to the database
8. Print the results

8.1. Press the # button to print the sizing report

Example 2

This example uses the Daily Sizing project to size a CO; application, overriding the predefined
fluid properties and does not utilize a tag number or quantity.

Fluid: Carbon Dioxide

Flow Rate: 1066 Ib/hr min | 63,943Ib/hr max
Inlet Pressure: 334 psig

Outlet Pressure: 84 psig

Temperature: 255 F

Compressibility: 0.7055
Specific Gravity: 1.5047

Upstream Pipe: 3in Sch 80
DownStream Pipe:  3in Sch 80
Valve Style: Control Valve

1. Create a new project item
1.1. Display the Project Item Wizard by selecting the File New Project Item... menu item or
pressing the EH button in the Project toolbar. If you have not saved any changes made to the
previous item, you will be asked to confirm saving the changes.
1.1.1. Since there is no tag number and the default valve style is for a Control Valve, press the
OK button.
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1.1.2. The new project item is created using the default name /tem 2 and added to the Daily
Sizing project.
1.2. Double-click on the Item 2 node in the project tree or press the Sizing Module button to begin
sizing the valve.
2. Service and fluid selection
2.1. Select Gas in the Service list box
2.2. Select Carbon Dioxide in the Fluid list box
3. Service parameters data entry
3.1. Minimum case
3.1.1. Flow Rate
3.1.1.1. Select /b in the Unit column
3.1.1.2. Select Ar in the Rate column
3.1.1.3. Enter 1066 in the Minimum column
3.1.2. Inlet Pressure
3.1.2.1. Select psi_g in the Unit column
3.1.2.2. Enter 334 in the Minimum column
3.1.3. Outlet Pressure
3.1.3.1. Enter 84 in the Minimum column
3.1.4. Temperature
3.1.4.1. Select F in the Unit column
3.1.4.2. Enter 255 in the Minimum column
3.2. Maximum case
3.2.1. Flow Rate
3.2.1.1. Enter 63943 in the Maximum column
3.2.2. Inlet Pressure
3.2.2.1. Enter 334 in the Maximum column
3.2.3. Outlet Pressure
3.2.3.1. Enter 84 in the Maximum column
3.2.4. Temperature
3.2.4.1. Enter 255 in the Maximum column
3.3. Override fluid properties
3.3.1. Select the Override checkbox
3.3.2. Compressibility
3.3.2.1. Enter.7055 in the Minimum and Maximum columns
3.3.3. Specific Gravity
3.3.3.1. Enter 1.5047 in the Minimum and Maximum columns
4. Calculate a preliminary C,
4.1. Press the 8 button to calculate
4.2. A preliminary C, of 1.187/71.2006 for Min/Max is displayed in the Sizing Results panel
5. Pipe and valve selection
5.1. Pipe Selection
5.1.1. Select 4.0 in the Upstream list box (the Downstream size is automatically selected)
5.1.2. Select XS in the Schedule list box (the Downstream schedule is automatically selected)
5.2. Valve Selection
5.2.1. Select 27004/2700E Control Valve for the Valve Model
5.2.2. Select 3.0 in the Valve Size list box
5.2.3. Select ANSI 300 in the Pressure Class list box (NOTE: ANSI 300 is rated up to 740psi)
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5.2.4. Select Equal Percentage (BCC) in the Trim Style list box
5.2.5. Select 2.0 in the Trim Size list box for a max C, of 77.2 (NOTE: Hovering the mouse
cursor over the list selections will display the rated Cv of the trim)
6. Calculate a final C,

6.1. Press the @ button to calculate

6.2. The Sizing Messages dialog is displayed, stating choked flow exists for both Min/Max
conditions, and that flow velocity exceeds .33 sonic under the Max condition. Press OK to close
the window.

6.3. A final C, of .9958/58.8476 is displayed in the Sizing Results panel, which is 1/76% of the
valve’s flow capacity under Min/Max conditions. The predicted noise generation is
72.5977/106.3498dB, which we will consider unacceptable at the Maximum condition.

7. Eliminate choked flow

7.1. Change the Pressure Drop to 225psi for both Min/Max conditions.

7.2. Press the @ button to calculate

7.3. The Sizing Messages dialog is displayed; choked flow is no longer applicable to either
conditions. Press OK to close the window.

8. Reduce valve outlet velocity

8.1. Method “A”

8.1.1. Change the Flow Rate to 60,000 for the Max condition

8.2. Method “B”

8.2.1. Change the Valve Size to 4.0

8.3. Press the & button to calculate

8.4. The Sizing Messages dialog is displayed; the valve’s outlet velocity is now acceptable. Press
OK to close the window.

9. Reduce the noise level

9.1. Change the Trim Style to DBII (BCC)

9.2. Press the # button to calculate

9.3. The Sizing Messages dialog is displayed, stating there were no messages generated by the flow
and noise calculations. Press OK to close the window.

9.4. A final C, of .9645/57.8625 is displayed in the Sizing Results panel, which is 1/62% of the
valve’s flow capacity under Min/Max conditions. The predicted noise generation is
<50/78.5692dB, which is now acceptable at the Maximum condition. (NOTE: Notice that the
critical pressure drop has changed. The Pressure Drop can be increased to more closely match
the original service condition of 250psi)

10. Save the results

10.1. Press the & button to save the item to the database
11. Print the results
11.1. Press the &# button to print the sizing report
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